
 

 

Lab 17314 

IBM PD Tools Hands-On Lab: Dive into Increased 
Programmer Productivity 

 

IBM Application Performance Analyzer 
for z/OS 

Eclipse interface 
 

Hands-on Lab Exercises 

  



 

IBM Application Performance Analyzer for z/OS V13 

 

Lab Exercises 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

© Copyright International Business Machines Corporation, 2015. All rights reserved.  

 

This document is intended for IBM internal use only. The contents of the document may be discussed with 

existing and/or potential customers. The document itself, however, may not be distributed outside of  

IBM.



 

____________________________________________________________________________________ 

Page 1  IBM Application Performance Analyzer for z/OS lab exercises 

Contents 

 

  Page 

Overview     2 

Lab 1:  Getting started with the Application Performance Analyzer perspective    5 

Lab 2:  Analyzing the performance of an application  11 

 

 
 

 

  



 

____________________________________________________________________________________ 

Page 2  IBM Application Performance Analyzer for z/OS lab exercises 

Overview  

 

Application Performance Analyzer 

IBM® Application Performance Analyzer for z/OS® is a tool that helps you perform application 

performance tuning for applications running on z/OS systems. 

Application performance tuning is the process of minimizing the amount of time and system resources 

that your application uses when it run. By system resources, it is typically referring to CPU time, and IO 

operations (such as reading and writing to files or databases). 

When should you perform application performance tuning? 

Most often, you will do application tuning when you have noticed a problem. For example, online 

transactions are running too long, and users are complaining about long response times. Or maybe a batch 

job that runs every day starts to run longer than usual, and does not complete in its scheduled time 

window. 

It is probably most typical to do application performance tuning when you notice that production 

applications have problems, that is slow response times or batch jobs running too long. And the focus of 

the tuning effort should be to fix performance bottlenecks. 

But it can also be advantageous to do performance tuning earlier in the application life cycle, during 

system testing. At this stage, you might be able to identify potential problems before they get to 

production. You can ensure that new applications meet your performance goals, and that changes that you 

have made will not have an adverse performance impact. 

So who does performance tuning?  There might be a lot of people who have roles in the application tuning 

process. And each can have a different perspective on the problem. An application developer might be 

more focused on the performance of a single application, or a set of applications. He or she might be 

interested in questions like, “Will a change make the program run slower?”. A Database Administrator 

might approach the issue from the perspective of how the database management system performs, and 

might be more interested in questions like “Can the database performance be improved?”. And a systems 

programmer might approach it from the perspective of the entire system, rather than individual 

applications, and might have interest in questions such as “Why is the entire system running slowly?”. As 

this chart implies, all of these people have overlapping interests. Questions like “Can the application be 

changed to run faster?” and “Can the job be changed to use less CPU and I/O” can be of interest to all. 

This is often best resolved through a collaborative effort. 

APA’s focus is on the application tuning process. There are other monitors, Omegamon for example, that 

are designed to provide information across multiple applications or for an entire system. APA is designed 

to help you understand the detailed performance characteristics of a single application. 

Some of the main features of Application Performance Analyzer are: 

• APA can collect detailed performance information about an application while it runs. After it has 

observed an application running, it processes the collected information, and presents it in 

formatted displays and reports. Most people use APA by accessing it through its online interface 

from TSO. 

• How does APA help you tune your application?  The most important thing that APA does is to 

help you answer the question: “Where is the application spending its time?”  For example, is it 

spending most of its time, using CPU cycles, reading or writing to files, or waiting on other 
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resources. And specifically, which programs or modules are causing the CPU or wait time. Based 

on the answer, you are better equipped to answer the question: “Can a change be made to the 

application or the system to make it run faster?” 

• Here is how it works. First, you request an observation session. The easiest way to do it is to use 

the online interface to tell APA to monitor your application while it runs. You can either monitor 

an application that is running right now, or schedule an observation session or sessions at some 

time in the future. During an observation session, APA collects performance information while the 

application runs, and stores the data in one or more measurement data sets. The observation 

request itself is stored in a file called the checkpoint file. 

• APA collects performance information using a sampling technique. When APA’s observation 

session begins, it takes one sample. That means that APA takes something like a snapshot of what 

the application is doing at one moment in time. It determines whether the application is actively 

using the processor or waiting for system resources, and it gets detailed information about the 

program, and even the instruction that is either using CPU time or waiting. APA retains the 

detailed information for that sample, and then waits for a fixed interval of time. Then it takes 

another sample, to find out what the application is doing at that moment, and collects information. 

For example, in this chart during the first two samples, the application was executing instructions 

in program A. During the third sample, it was executing instructions in a system module. During 

the next three samples, it was waiting for an I/O operation to complete. At any point in time, an 

application can only be in one of three states. It can be executing instructions in a program, which 

means it is using CPU time. It can be waiting for a system resource, such as for a file I/O 

operation to complete. Or, it can be waiting because the system CPU is busy servicing other 

processes.  Over time, APA will collect a statistically significant set of samples. And when 

aggregated, it gives you detailed information about where the application spends most of its time. 

• When you are using a monitor to collect performance information about an application, there is 

sometimes a concern about how much overhead the monitor has. First, be aware that APA runs in 

its own address space, so most of APA’s processing does not increase the resource usage of the 

application being monitored. Of course, APA does use some CPU cycles to do its work, although 

most typically it will have no measurable impact on the application. However, APA reports 

exactly how much CPU time it uses. System overhead from a single APA session is typically 

insignificant and does not skew measurement statistics. But if it is still a concern, you can control 

APA’s sampling rate. 

• After an APA observation session has completed, the information is presented to you using 

analysis reports. You can view and print these reports. Most people view the reports directly using 

the APA online interface in TSO. Or you can print reports to SYSOUT, or even generate PDF files 

that you can download to your workstation and print from there.. APA generates its reports by 

aggregating data from the measurement data sets. Sample file data can also be written to a file in 

XML format and viewed in an XML reader. 

• You can view a wide range of performance reports. Here are just a few. There are reports that 

describe CPU usage, and these reports are broken down by program or module, and you can even 

drill right down to the program statements that use the most CPU time. There are similar reports 

for wait time. Using these reports, you can identify which programs or modules caused the most 

wait time, and drill right down to the program statements. For DB2 applications, there are reports 

containing various metrics, broken down by SQL statement, by the plan, by the thread, and so on. 

For CICS applications, the information is broken down by transaction, by task, by program, and 
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much more. For IMS applications, there are reports broken down by CPU time and by call service 

time. And there are reports that provide information about disk usage and storage. 

• One of the best features of APA is that you can drill down to program statement level, to identify 

exactly which statements caused the most CPU time and wait time. APA can perform this source 

mapping for the programs using the IBM compilers that is indicated on the slide. They include 

COBOL, PLI, C, C++, Java, and Assembler. To enable source mapping in APA, source 

information must be saved when your programs are compiled. Depending on the compiler, source 

information can be saved in the form of compiler listings, SYSDEBUG files, LANGX files, or 

assembler ADATA files. 

• When you request an observation session, the entry is stored in the checkpoint file. The checkpoint 

entry contains information about the session, and is updated as the session starts, and completes. 

• In a SYSPLEX environment, the checkpoint file can be on shared DASD. That way, you can 

request an observation session from one LPAR for an application that is running on another 

LPAR. Also, information in the checkpoint file is retained across IPLs. So you can request an 

observation session to run at some future time, and the request is retained even if the system is 

IPLed. 

• Sampling data from observation sessions are stored in measurement data sets. Measurement data 

sets are allocated automatically by APA when an observation session starts. The names of the files 

are controlled by the person who installs APA. If you delete an observation session, the 

measurement data sets are also deleted automatically.  

 

This workbook 

This workbook contains instructions for lab exercises that are designed to give you hands-on experience 

for the eclipse interface of IBM Application Performance Analyzer for z/OS. 

 

Reference 

Product manuals and other information about IBM Application Performance Analyzer for z/OS, and other 

IBM problem determination tools, are available on the Web at URL:  

http://www.ibm.com/software/awdtools/deployment    

 



 

____________________________________________________________________________________ 

Page 5  IBM Application Performance Analyzer for z/OS lab exercises 

Lab Exercise 1 

Getting started with the Application Performance Analyzer 

perspective 

 

In this exercise you will: 

� Open the Application Performance Analyzer perspective in the Eclipse workbench. 

� See the simple process of downloading reports from the host. 

� Learn how to display help information for Application Performance Analyzer. 

� Map source listing to see the lines of code that are suspect to performance. 

 

1. Before you begin, you must have the Eclipse interface open on your workstation. If you aren’t sure how to 

open it, please contact your instructor. 

 

In eclipse, a perspective is a set of views (windows), menus, and options that provide a set of functions. The 

File Manager interface is a perspective. Before you can use File Manager, you need to open it’s perspective.   

 

2. Opening the Application Performance Analyzer perspective. 

a. From the menu bar near the top of the eclipse workbench, select Window > Open Perspective > 

Application Performance Analyzer. 

i. Note: If “Application Performance Analyzer” is not shown as a selection, then the Application 

Performance Analyzer perspective is already open and you can proceed to the next step. 
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The Application Performance Analyzer perspective is displayed. Note: the contents of the Systems 

Information view may be different or even blank on your system.   

 

 

3. Notice that ReqNum 0084 was highlighted and expanded then a right mouse click reveals a pop-up window 

for downloading reports to your workstation. 

4. You can display help information to assist with various features of Application Performance Analyzer.  

a. To open the help dialog, select Help > Help Contents. 

 

 

b. The Help dialog is displayed. To expand the Application Performance Analyzer help topics, click the 

plus ( + ) next to IBM Application Performance Analyzer for z/OS User’s Guide. 

RT 

click 



 

____________________________________________________________________________________ 

Page 7  IBM Application Performance Analyzer for z/OS lab exercises 

 

 

Under IBM Application Performance Analyzer for z/OS User’s Guide, you can expand the Using 

APA section which covers several topics. 

 

c. You should now have a good understanding how to display general help information.  

d. Close the help dialog: click the X (close) icon in the upper right corner of the help window. 
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5. You can also display a list of keyboard commands.  

a. In the eclipse workbench Select Help >  Key Assist. 

 

 

 

b. A list of keyboard commands is displayed. 

 

 

6. Note: As you work through the exercises, you may accidentally close or hide a view (a window) or other 

parts of the Application Performance Analyzer perspective. Remember that if that happens, you can easily 

reset the perspective to its default views. Try it now, so you know how to perform the reset: 

• From the menu, select Window > Reset perspective. 

• The perspective is reset. The default views are displayed in their default positions and with their 

default sizes.   

7. Now that the Application Performance Analyzer perspective is open, and you know where to find help, you 

are ready to start using Application Performance Analyzer in the following exercises. 
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Note: In the next exercise you will be reviewing reports generated from a batch application.  The APA 

observation was set-up to start when a specific batch application appeared active in an initiator.  The 

observation included all steps for one CPU minute and collected 10,000 samples.  The GUI APA made a 

request to the host to download all the reports to the workstation.  Observations can be set-up for batch, 

online, etc. and can specify the rate of sampling, when to begin and on what step.  Threshold observations can 

be used too.  The next lab will focus on the reports that are generated. 

You have completed this exercise.  
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Lab Exercise 2 

Analyzing the performance of an application  

 

In this exercise you will: 

� See the CAZ0 report of reports which contain the following reporting areas: 

a. S - Statistics/Storage 

b. C - CPU Usage Analysis 

c. D - DASD I/O Analysis 

d. W - CPU WAIT Analysis 

e. G - Coupling Facility 

f. J – Java Measurement 

� Each category can be drilled down into sub categories. 

� You will see the program source mapping against the reports. 

� The program source mapping will provide indictors for the category and the source the program spent 

the most time in the lines highlighted. 

 

Introduction to Application Performance Analyzer Reports 

Overview of reports. 

Overview of categories. 

Overview of source mapping and reporting. 
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1. In the Systems Information Tab, under the z/OS system that you will use during this exercise, select 

Application Performance Analyzer for z/OS > ESYSMVS > CAZ0 

  

 

 

 

 

2. Here’s an example of a typical APA Observations List (CAZ0) – Local.  The notes below point out color 

coding and status states. 
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3. We already set-up an observation in APA.  Once the specific batch job runs, reports are available. 

a. We discussed how in the GUI APA you can download reports from the host.  This is a typical pop-up 

screen showing the progress of the download. 

 

 

b. The job we observed had multiple steps.  Our concern is in step 8.  Below, you can see the ReqNum is 

0084.  The owner, jobname and date/time are also available.  ReqNum 0092 is the multi-step reference. 
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4. Details (0092) tab shows General observation information. 

 

5. Reports (0092) shows the breakdown of the report categories. 
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6. Reports (0092) shows the breakdown of the report categories and sub-categories for Statistics/Storage. 

 

7. Reports (0092) shows the breakdown of the report categories and sub-categories for CPU Usage Analysis. 
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8. Reports (0092) shows the breakdown of the report categories and sub-categories for DASD I/O Analysis. 

 

 

9. Reports (0092) shows the breakdown of the report categories and sub-categories for CPU WAIT Analysis. 
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10. Reports (0092) shows the breakdown of the report categories and sub-categories for Coupling Facility. 

 

 

 

11. Reports (0092) shows the breakdown of the report categories and sub-categories for Java Measurement. 
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12. Returning to the Statistics/Storage report categories and then clicking on the S01 report… 

  

 

13. The S01: Measurement Profile is displayed and, by the way, is a good place to start your analysis. 

 

a. In the upper right hand of the S01 report there is a full screen button.  You can simply left mouse button 

click the full screen and then use the page up/down buttons or the scrolling slide bar to navigate the 

reports.  The blocks on the left side present the measurement information gathered and the blocks on 

the right side contain a list of related reports.  You can simply select a report and left mouse click it to 

drill down into the associated report.  Let’s scroll all the way to the bottom of the S01 report to see 

what’s available and associated. 

b. The Overall CPU Activity gives you APA’s analysis of where the application spent time: 

i. CPU Active. 

ii. WAIT. 

iii. QUEUED. 
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c. With the S01 report filling the screen, use the mouse to hold and scroll the page.   

d. Notice much of the time is in application modules 
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e. After scrolling, the complete section on CPU Modes is available. 
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f. And the last page of the S01 report is displayed. 

         

 

 

 

 

 

 

 

 



 

____________________________________________________________________________________ 

Page 21  IBM Application Performance Analyzer for z/OS lab exercises 

14. Open the W03 report and expand all the names with the “plus” icon.  Right click the SAM1V CSECT.  

Then right click the Source Program Mapping.  

 

15. Source for the program is displayed on the W03 report now, showing which statements caused the most wait 

time. 

 

Expand 

All 
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16. The C01 report and source mapping shows the statements that caused the most CPU consumption. 

 

17. C08 and source mapping provide referred attribution reporting. 
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Tip: If Application Performance Analyzer has captured new abends since you opened a fault history file, you 

can refresh it. In the Systems Information view, right-click the Fault History file and select Reload history 

file from host.   

18. You have completed this exercise.  
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Summary 
 

Congratulations, you have completed the exercises and have familiarized yourself with the Application 

Performance Analyzer eclipse interface. 

 

In these two labs: 

• You opened the APA perspective. 

• You reviewed the report download process. 

• You learned to get HELP screens and pop-ups. 

• You learned the layout of the CAZ0 report. 

• You learned abut six of the report categories. 

• You learned how to drill down into sub-categories of reports. 

• You learned about the displaying the W03, C01, & C08 reports with source mapping. 

 

If you have any questions about Application Performance Analyzer, please contact the instructor. 
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